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1 Installation  
STEP 1 

 
Run the FXCC_MultiTerminal_Setup.exe file, read through the information and click the 

"Next" button to continue. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

STEP 2 
 

Read through the End-User Licence Agreement and click the "Yes, I agree with all terms of this 
license agreement" box to agree with the terms, and then click the "Next" button to continue. 
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1 Installation  
STEP 3  
Select the installation folder, then click "Next". 

 
 
 
 

 
 

STEP 4 
 

Once the installation process has been completed click the "Finish" button. 
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2 Terminal 
 

Main Menu 
 

 
 

2.1 File Menu 
 
 

 

 
 
 

1. Connect all: Connect all listed accounts. 
 

2. Disconnect all: Disconnect all listed accounts. 
 

3. New account: User can add a new account to the list of managed accounts. 
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2.2 Edit Menu  
This menu offers Find and Copy commands. 

 
        Copy Find 

 
 
 
 
 
 
 
 
 
 
 
 
After clicking on the Find Menu item, a window appears where the user can search for what they 
require. 
 
 
 
 
 
 
 
 
 

2.3 View Menu 
 

The following options are available in the View tab: 
 

1. Languages: Select desired language based on personal preference. The 

Terminal must be restarted for the changes to apply.  
2. Toolbar: Select or deselect the Toolbar option to show or hide the Terminal. 

 
3. Status Bar: Select or deselect the Status Bar option to show or hide the Status Bar. 

 
4. Market Watch: Select to show or hide the Market Watch window, where the quotes 

(Bid/Ask) for the different financial instruments are shown.  
5. Accounts: Select to show or hide the Accounts window, where the lists of all the 

accounts are shown.  
6. Toolbox: Select to show or hide the Toolbox window. 

 
7. Full Screen: Select this to enable or disable the full screen mode. 

 
 
 
 

2.4 Tools Menu 
 

Options 
 

The user can set up the core functions by selecting "Tools" 
and then "Options". Once "Options" is selected, a window 
appears, showing the following tabs: 
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1. Server: Contains parameters of server connections. Proxy server, personal settings and news 
can be enabled. 

2. Trade: Select default settings of opening new orders. Settings "Such as" the default 
symbol that the user wishes to appear when opening a new order, desired lot size, lots 
allocation mode and deviation.  

3. Email: Set up email parameters. 
 

4. Events: Set up settings of sounds for Terminal connection/disconnection, email, time 
out and price re-quotes. 

 
2.4.1 Options Tabs 

 
 

2.4.1.1 Sever 
 

The server tab contains options for the server and data center connection. 
 

 
 

In this window, ensure the "Data Center auto configuration", "Keep personal settings and data 
at startup" and "Enable news" boxes are selected. "Enable proxy server"  
should remain unselected. 

 
 
 
 

2.4.1.2 Trade 
 

The user has the following options to choose 
from: 
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1. Symbol by default: Allows the user to set the currency pair that is displayed by default 
when an order window is opened. If the user selects the "Last Used" option it means that 
the latest trade will define the symbol. 

2. Lots by default: The user is able to set the default amount of lots to be traded. If the "Lots 
by default” option is selected then the amount is defined by the previous trade. If the user 
selects the Default option then the value can manually be set. 

 
3. Lots Allocation: The lots allocation specifies the total lots that will be distributed among the 

assigned accounts based on the method selected. 
a. Predefined Volume: The deal size must be predefined each time a position is 

opened. If "Last Used" is selected, the predefined volume set on the previous trade 
will apply. 

b. Total Volume for Each Order: The total volume for each order is set and applies 
equally to all allocated accounts. If “Last Used" is selected, the total volume used on 
the last trade will apply. 

c. Equal Parts: The total lots is equally divided and allocated to the volumes of the 
assigned accounts before placing a trade. 

d. By Equity Ratio: The total lots will be allocated to all assigned accounts according to 
the ratio of the accounts’ equities. 

e. By Free Margin Ratio: The total lots will be allocated to all assigned accounts 
according to the ratio of the accounts’ free margins. 

 
4. Deviation: Sometimes prices can move fast while the order is executed. The user can set 

the maximum deviation of the order price with the market price. If the market price exceeds 
the value set then the position will not be opened. 

 
 

2.4.1.3 Email 
 

Mailbox can be set in this tab. To receive emails, select the "Enable" box and fill in the required 
fields, then click "OK". 
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2.4.1.4 Events 
 

The user can set signals for system events. Specific events can be disabled or enabled by double 
clocking on each name.  
1. Connect: Signal after a server connection. 

 
2. Disconnect: Signal of a failed server connection. 

 
3. Email Notify: Signal of a mail received in Inbox which can be read at the Toolbox and then 

Mailbox tab.  
4. OK: Signal when trade was done successfully. 

 
5. News: Signal of receiving news, which can be read at the Toolbox and 

then the News tab.  
6. Requote: Signal when the price changes during the execution of a trade. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.5 Windows 
 
 

1. Orders: Opens the Orders window. 
 

2. History: Opens the closed positions History window. 
 

3. New Order: Opens the New window. 
 

4. Close Order: Opens the Close window. 
 

5. Pending Order: Opens the Pending window. 
 

6. Modify Order: Opens the Modify window 
 

7. Delete Order: Opens the Deleting window. 
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2.6 Help 
 
The user can use the "Help Topics" built-in files and the "About" option 
where information about the company and the Terminal version is shown. 
 
 
 
 
3 Meta Trader User Interface 
 
 

There are four main windows in the MT4 MultiTerminal. 
 

• Market Watch 
 

• Toolbar 
 

• Accounts 
 

• Order Management 
 

The first three main windows can be activated by clicking "View" in the toolbar, then select 
"Market Watch", "Toolbar", "Accounts" menu sequence. 

 

 
 

3.1 Market Watch (Real-time quotes) 
 

The "Market Watch" window shows you the real-time quotes of the currency pairs. Each 
currency pair's Bid and Ask prices are shown, displaying in a vertical window on the left. 

 
The "Symbol" column shows the symbol name and the "Bid" and "Ask" show the 
corresponding prices the client can buy or sell from the market. If you double click  
on any currency pair, then the Order window will open. This window can also be activated 
by pressing the "Ctrl+M" key combination, or by the "Market Watch" under the "View" tab 
on the menu command. 
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Right-click on the "Market Watch" window to produce the content menu as shown: 
 

 
 

1. Tick Chart: Shows the tick chart for the selected instrument 
 

2. Hide: Hides the specified symbol from the list in the "Market Watch" window. 
 

3. Hide All: Hides all symbols from the list in the "Market Watch" window which are not used (if you 
have open positions or charts, its symbols will not be deleted). 

 
4. Show All: Displays all available symbols in the "Market Watch" window. 

 
5. Symbols: Enables the window where you can hide/show the selected instruments. 

 
6. Auto Arrange: Automatic arranging of columns when changing the window size. Auto arrange 

can also be enabled by right clicking on any symbol and pressing "A". 
 

7. High/Low: Shows/hides columns with the highest and the lowest prices for each 
instrument. 

 
8. Time: Displays a column with the arrival time of the latest quote for each instrument. 

 
9. Grid: Hides/unhides gridlines in the "Market Watch" window. 

 
10. Popup Prices: Opens the popup window which contains real time quotes for your selected 

instruments. 
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3.2 Toolbox 
 

3.2.1 News 
 

In the "News" tab, the incoming news will be published and arranged according to the time. 
 
 
 
 
 
 
 
 
 
 
 

3.2.2 Alerts 
 

The "Alerts" tab allows the user to set alerts for specific conditions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.2.3 Mailbox 
 

In the "Mailbox" tab the user can find the messages sent to the Terminal. 
 

 
 
 

3.2.4 Journal 
 

The "Journal" tab shows all the operations and 
activities which are shown as text entries. 
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3.3 Accounts 
 

In the "Accounts" section, Balance, Equity and 
Margin level of all the accounts are shown. 

 
 
 
 
 
 

3.4 Order Management 
 

3.4.1 How to Open a Position 
 

Market Watch: Double click the symbol you want to trade. Every account will be shown in a list 
and the user must deselect the account(s) he/she does not want to open a position for. 
 

 
 

1. Symbol: Shows the type of product such as currency pairs, gold spot, or silver. 
 

2. Stop Loss: A price to close an open position at a less profitable price to the customer than 
the price at the time of placing the order. If a price is not specified, zero will be entered in 
this field. The Stop Loss price will be filled in red if an order was closed by the Stop Loss, or 
the distance between the current price and the Stop Loss price of an open order is less than 
10 pips.  

3. Take Profit: A price to close an open position at a more profitable price to the customer than 
the price at the time of placing the order. If a price is not specified, zero will be entered in this 
field. The Take Profit price will be in green if an order was closed by the Take Profit, or the 
distance between the current price and the Take Profit price of an open order is less than 10 
pips.  

4. Comment: The user can include a comment for each trade. It is not obligatory but once 
the trade is placed, the comment cannot be altered.  

5. Total Volume: Defines the lot amount that will be allocated to the assigned accounts 
according to the allocation method used  
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6. Lots Allocation: When placing new orders, it is necessary to specify the total lots 
allocation for all accounts. The specified total lots will be distributed among accounts 
according to the specified lots allocation method: 

• Predefined volume: it will be necessary to manually specify the lots amount for each order 
when placing the order, later this predefined volume will apply at placing orders.  

• Total volume for each order: the total lots will apply at placing each order. 
• Equal parts: the total lots will be allocated among all orders in equal parts.  
• On equity ratio: the total lots will be allocated among orders based on the ratio between 

equities of accounts.  
• On free margin ratio: the total lots will be allocated among orders on the ratio between free 

margins of accounts. The "Lots Allocation" option allows defining 
 

 
 

3.4.2 How to Place a Pending Order 
 

A pending order allows the user to buy or sell a symbol at a pre-defined price in the future. This 
type of order is used for opening a trade position when future quotes reach the predefined level. 
If the price of the market satisfies the order condition, the pending order will be executed 
automatically. 

 
If you would like to place a pending order, you need to place it under the "Pending" tab. 

 
 

 
 

There are four types of pending orders available: 
 

1. Buy Limit: Place a Buy order, provided the future "Ask" price is equal to the pre-defined value. 
The current price level is higher than the value of the placed order. This type of order is usually 
placed in anticipation that the symbol price, having fallen to a certain level, will increase. 

 
2. Buy Stop: Place a Buy order, provided the future "Ask" price is equal to the pre-defined 

value. The current price level is lower than the value of the placed order. This type of order is 
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usually placed in anticipation that the symbol price, having reached a certain level, will 
continue to rise. 

 
3. Sell Limit: Place a Sell order, provided the future "Bid" price is equal to the pre-defined value. 

The current price level is lower than the value of the placed order. This type of order is usually 
placed in anticipation that the symbol price, having increased to a certain level, will fall. 

 
4. Sell Stop: Place a Sell order, provided the future "Bid" price is equal to the pre-defined value. 

The current price level is higher than the value of the placed order. This type of order is usually 
placed in anticipation that the symbol price, having reached a certain level, will continue to 
fall. 

 
 

After selecting "Pending Order", you can select the following parameters: 
 

1. Symbol: The type of product you wish to trade. 
 

2. Stop loss: A price to close an open position at a less profitable price to the customer than the 
price at the time of placing the order. If a price is not specified, zero will be entered in this 
field. The Stop Loss price will be filled in red if an order was closed by the Stop Loss, or the 
distance between the current price and the Stop Loss price of an open order is less than 10 
pips. 

 
3. Take profit: A price to close an open position at a more profitable price to the customer than 

the price at the time of placing the order. If a price is not specified, zero will be entered in this 
field. The Take Profit price will be in green if an order was closed by the Take Profit, or the 
distance between the current price and the Take Profit price of an open order is less than 10 
pips. 

 
4. Comment: The user can include a comment for each trade. It is not obligatory but once the 

trade is placed, the comment cannot be altered. 
 

5. Total Volume: Defines the lot amount that will be allocated to the assigned accounts 
according to the allocation method used 

 
6. Lots Allocation: The lots allocation specifies the total lots that will be distributed among 

the assigned accounts based on the method selected.  
 

7. Open Price: Price level at which the order will be triggered. 
8. Type: Buy Limit, Buy Stop, Sell Limit, Sell Stop. 

 
9. Expiry: The execution will be pending if Expiry box is not selected. If the box is selected, the 

date can be set on the preferred pending order. The selected pending order will be deleted 
after the specified date. 

 
Click the "Place" button to complete your order. You can also see your order in "Trade" in the 
"Terminal". 
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3.4.3 How to Close an Order 
 
Clients can close their open positions from the "Close" tab and select the financial instrument 
in the "Symbol" section. The user must select the account(s) he/she wants to close a position 
for and leave unselected the positions he/she wishes to remain open. 
 

 
 
3.4.5 Multiple Close By Order 
 
It is possible to close more than one positions of opposite direction and same financial instrument 
simultaneously. In the "Multiple Close By" tab, every account that has open  
positions of the same financial instrument and different direction to the position of the managed 
account will be presented in a list. Do not select the positions that wish to be remained open. 
After selecting the desired positions, the user can select  
"Multiple Close By". 
 
 
 
 
 
 
 
 
The "Multiple Close By" function will lead to the opening of a new position, if the difference 
between open positions of the same financial instrument that are opposite direction is not 
equal to zero. This new position will follow the earlier opening time.  
Considering that earlier orders are closed first, the newly opened trades will continue to 
participate in the "Multiple Close By" function until all positions are closed. 
 
3.4.6 How to Modify an Order 
 
To modify a position, the user must use the "Modify" tab. Modifying a current position can be setting 
of stop losses and/or take profits, or in the case of pending orders, setting an expiry date or 
changing the open price. 
Users can select the orders they wish to modify and enter the new details, clicking "Modify" 
to complete the update. 
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3.4.7 How to Delete an Order 
 
Use the "Delete" tab if you need to delete a pending order. Users can select any orders to delete using 
the check boxes and delete by clicking the "Delete" button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 For further assistance regarding the MT4 MultiTerminal application, please feel free to contact us: 

Phone : +357 25 870750, +357 25 025001  |  Email: support@fxcc.com  |  Chat: Chat now 

mailto:support@fxcc.com
https://secure.livechatinc.com/licence/1097514/open_chat.cgi?lang=en&groups=0
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